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Pro Tools M-Powered Essential Shortcuts

(for Pro Tools M-Powered Essential on Mac and Windows)
For increased operational speed and ease-of-use, there are many Pro Tools® keyboard and Right-click shortcuts to give you fast ac-
cess to a wide variety of tasks. This guide lists all keyboard shortcuts and Right-click shortcuts available in each window of 
Pro Tools. Shortcuts are grouped by functional area for your added convenience and quick reference.
Conventions Used in This Guide

Digidesign® guides use the following conventions to indicate menu choices and key commands:

Menu commands that have a keyboard shortcut display their keyboard shortcut on-screen, to the right of the menu command.
Convention Action

File > Save Session Choose Save Session from the File menu.

Command+N/Control+N Hold down the Command (Apple) key (Mac) or the Control (Ctrl) key (Windows) and 
press the N key.

Option+Plus/Minus (+/–) keys Hold down the Option key and press the Plus (+) or Minus (–) key (on numeric keypad 
or QWERTY, as noted).

Command-click (Mac Only) Hold down the Command key and click the mouse button.

Right-click Click with the right mouse button.
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Keyboard Shortcuts

Global Keyboard Shortcuts
The following shortcuts can be used in all Pro Tools windows for the features noted.

Action Mac Windows

Parameter change

• Automation mode • Monitor mode • playlist enable • record, solo and mute enable • record and solo safes • inserting plug-ins 
• I/O, bus, send assignment • volume/peak indicator • extend Edit or Timeline selection • track height • clear clip meter

Change parameter on all channel strips Option+applicable function (applicable 
functions listed above)

Alt+applicable function (applicable 
functions listed above)

Change parameter on all selected channel strips Option+Shift+applicable function 
(applicable functions listed directly 
above)

Alt+Shift+applicable function (applica-
ble functions listed above)

Toggle

• Tracks in Track List • Group enables/activation • Automation Enable window • Memory Location parameters

Toggle item and set all others to same new state Option-click on applicable item (appli-
cable items listed above)

Alt-click on applicable item (applicable 
items listed above)

Toggle item and set all others to opposite state Command-click on applicable item 
(applicable items listed directly above)

Control-click on applicable item (appli-
cable items listed above)

Fine Tune adjustment

• Plug-in parameter editing • fader movement • scrubbing • automation data trimming (requires larger Track View for highest resolution) 

Fine Tune (Fine Adjust mode) Command-click on applicable 
fader/pot/breakpoint function (appli-
cable functions listed above)

Control-click on applicable 
fader/pot/breakpoint function (appli-
cable functions listed above)

Multi-select

• Tracks • regions in Region List • paths in I/O Setup

Select multiple contiguous items (tracks, regions, paths) Click to select first item, then 
Shift-click another to select all similar 
items between (applicable items listed 
above)

Click to select first item, then 
Shift-click another to select all similar 
items between (applicable items listed 
above)

Select multiple non-contiguous items (tracks, regions, 
paths)

Click to select first item, then Com-
mand-click another to select all similar 
items between (applicable items listed 
above)

Click to select first item, then Con-
trol-click another to select all similar 
items between (applicable items listed 
above)
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Pro Tools Edit Window and Mix Window Keyboard Shortcuts
The following keyboard shortcuts can be used in the Edit window and Mix window for the features noted.

Action Mac Windows

Playback

Start/stop playback Spacebar Spacebar

Pause (pre-prime deck for instant playback and record) Control+Spacebar, or Option-click, on 
Transport Play button

Start+Spacebar, or Alt-click on Trans-
port Play button

Center on selection start/end Left/Right Arrow keys (when selection 
exceeds window view)

Left/Right Arrow keys (when selection 
exceeds window view)

Loop playback toggle Command+Shift+L, or Control-click on 
Transport Play button

Ctrl+Shift+L, or Start-click on Trans-
port Play button

Dynamic Transport Mode toggle Command+Control+P Ctrl+Start+P

Transport Master toggle (Pro Tools/Machine/MMC) Command+Backslash (\) Ctrl+Backslash (\)

Solo-safe track Command-click on track Solo button Ctrl-click on track Solo button

Record

Start record Command+Spacebar, F12, or 3 (on 
numeric keypad)*

Ctrl+Spacebar, or F12, or 3 (on 
numeric keypad)

Stop record Spacebar Spacebar

Stop record and discard recording take (not undoable) Command+Period (.) Ctrl+Period (.)

Record-safe track Command-click on track Record Enable 
button

Ctrl-click on track Record Enable but-
ton

Loop Record toggle Option+L Alt+L

Enable or disable pre/post-roll time Command+K Ctrl+K

*Some Pro Tools recording shortcuts use the same key commands as some Mac OS X shortcuts. If you want to retain use of these key 
commands in Pro Tools, these Mac OS X shortcuts must be disabled. For more information, see the Essential User Guide.

Transport Mode using Numeric Keypad

• Select Numeric Keypad: Transport in the Operations Preferences page.

Play/Stop 0 0

Rewind 1 1

Fast Forward 2 2

Record Enable 3 3

Loop Playback mode on/off 4 4

Loop Record mode on/off 5 5

Click on/off 7 7

Countoff on/off 8 8

MIDI Merge/Replace mode on/off 9 9
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Auditioning

Play by pre-roll value up to selection start/end (or current 
location if no selection)

Option+Left/Right Arrow keys Alt+Left/Right Arrow keys

Play by post-roll value from selection start/end (or current 
cursor location if no selection)

Command+Left/Right Arrow keys Ctrl+Left/Right Arrow keys

Play by pre- and post-roll value through selection start/end Command+Option+Left/Right Arrow 
keys

Ctrl+Alt+Left/Right Arrow keys

Edit Modes and Tools

Slip mode F2, or Alt+2 (on QWERTY keyboard) F2, or Option+2 (on QWERTY keyboard)

Grid mode F4, or Alt+4 (on QWERTY keyboard) F4,or Option+4 (on QWERTY keyboard)

Enable Snap To Grid while in another Edit mode Shfit+F4 Shfit+F4

Enable Snap to Grid and Shuffle mode F1+F4 F1+F4

Enable Snap to Grid and Slip mode F2+F4 F2+F4

Enable Snap to Grid and Spot mode F3+F4 F3+F4

Zoomer tool F5, or Command+1 (on QWERTY key-
board)

F5, or Ctrl+1 (on QWERTY keyboard)

Trimmer tool F6, or Command+2 (on QWERTY key-
board)

F6, or Ctrl+2 (on QWERTY keyboard)

Selector tool F7, or Command+3 (on QWERTY key-
board)

F7, or Ctrl+3 (on QWERTY keyboard)

Grabber tool F8, or Command+4 (on QWERTY key-
board)

F8, or Ctrl+4 (on QWERTY keyboard)

Pencil tool F10, or Command+6 (on QWERTY key-
board, if Mac OS X Expose is disabled)

F10, or Ctrl+6 (on QWERTY keyboard)

Cycle through Edit tools Escape (Esc) key Escape (Esc) key, or Center-click

Edit Selection, Definition, and Navigation

Enable or disable Tab to Transients command Command+Option+Tab Ctrl+Alt+Tab

Locate cursor to next transient Tab (if Tab to Transient enabled) Tab (if Tab to Transient enabled)

Locate cursor to previous transient Option+Tab (if Tab to Transient 
enabled)

Ctrl+Tab (if Tab to Transient enabled)

Locate cursor to next region-boundary/sync point Tab (if Tab to Transients button is dis-
abled)

Tab (if Tab to Transients button is 
enabled)

Locate cursor to previous region boundary/sync point Option+Tab (if Tab to Transients button 
is disabled)

Ctrl+Tab (if Tab to Transients button is 
enabled)

Go to and select next region Control+Tab Start+Tab

Go to and select previous region Control+Option+Tab Start+Ctrl+Tab or Start+Ctrl

Go to Song Start Control+Return Start+Enter

Extend selection to Song Start Shift+Control+Return Shift+Start+Enter

Extend selection to next region-boundary Shift+Tab Shift+Tab

Extend selection to previous region-boundary Option+Shift+Tab Ctrl+Shift+Tab

Action Mac Windows
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Extend selection to include next region Control+Shift+Tab Start+Shift+Tab

Extend selection to include previous region Control+Shift+Option+Tab Start+Shift+Ctrl+Tab

Return to start of session Return Enter

Go to end of session Option+Return Ctrl+Enter

Extend selection to start of session Shift+Return Shift+Enter

Extend selection to end of session Option+Shift+Return Ctrl+Shift+Enter

Link Timeline and Edit selection Shift+Forward Slash (/) Shift+Forward Slash (/)

Set selection start/end during playback Down/Up Arrow keys Down/Up Arrow keys

Set selection start/end to incoming time code while 
stopped

Down/Up Arrow keys Down/Up Arrow keys

Select entire region in Edit window Double-click with Selector Double-click with Selector tool

Select entire track in Edit window Triple-click with Selector, or single-click 
in track and press Command+A

Triple-click with Selector tool, or sin-
gle-click in track and press Ctrl+A

Select all regions in all tracks in Edit window Return, then press Command+A Enter, then press Ctrl+A

Move the selection backward by the selection amount Command+Control+Option+L Ctrl+Alt+Start+L

Double the length of the Edit selection Command+Control+Option+Shift+ 
Apostrophe (‘)

Ctrl+Alt+Start+Shift+Apostrophe (’)

Halve the length of the selection Command+Control+Option+Shift+L Ctrl+Alt+Start+Shift+L

Cancel Zoom toggle and remain at the same zoom level Option+Shift+E Alt+Shift+E

Fit all shown tracks in the Edit window Command+Option+Control+Up arrow 
or Down arrow

Ctrl+Alt+Start+Up

Record enable tracks that contain the Edit cursor or Edit 
selection

Shift+R Shift+R

Solo tracks that contain the Edit cursor or Edit selectio Shift+S Shift+S

Mute tracks that contain the Edit cursor or Edit selection Shift+M Shift+M

Move the insertion to the beginning of the Edit selection Down arrow Up arrow

Move the insertion to the end of the Edit selection Up arrow Down arrow

Increase or decrease the height of any lane that contains 
the Edit cursor or an Edit selection

Control+Up/Down Arrow Start+Up/Down Arrow

Editing, Nudging, and Trimming

• In the following shortcuts, the Plus/Minus (+/–) key usage is on the numeric keypad only.

Change Grid value Control+Option+Plus/Minus (+/–) 
keys

Start+Alt+Plus/Minus (+/–) keys

Reverse Trimmer tool direction when trimming region Option+Trimmer tool Alt+Trimmer tool

Trim up to, but not over, adjacent regions Hold down Control key while trimming Hold down Start key while trimming

Duplicate region(s) in Edit window Option-click selection and drag to des-
tination

Alt-click selection and drag to destina-
tion

Delete selection in playlist Backspace or Delete (on QWERTY key-
board)

Backspace or Delete (on QWERTY key-
board)

Action Mac Windows
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Constrain audio region to vertical movement Control-click to move audio region with 
Grabber tool

Start-click to move audio region with 
Grabber tool

Snap region start to stationary playhead or Edit selection 
start

Control-click new region with Grabber 
tool

Start-click new region with Grabber tool

Snap region sync point to stationary playhead or Edit selec-
tion start

Control-Shift-click region containing the 
sync point with Grabber tool

Start-Shift-click region containing the 
sync point with Grabber tool

Snap region end to stationary playhead or Edit selection 
start

Command-Control-click new region 
with Grabber tool

Ctrl-Start-click new region with Grabber 
tool

Zoom

Horizontal zoom in or out Command+ ] or [ Ctrl+ ] or [

Zoom to show entire session horizontally without affecting 
vertical zoom or scrolling

Command+Control+[ Ctrl+Start+[

Zoom in horizontally on a selection without affecting vertical 
zoom or scrolling

Command+Control+] Ctrl+Start+]

Vertical zoom to show default waveform height (Audio) Command+Option+Control+[ Ctrl+Alt+Start+[

Incrementally zoom vertically on all audio tracks Command+Option+ [ or ] Ctrl+Alt+ [ or ]

Vertical zoom in or out (MIDI) Command+Shift+ ] or [ Ctrl+Shift+ ] or [

Vertical zoom to show all notes (lowest to highest) in MIDI 
and Instrument (MIDI)

Command+Control+Shift+[ Ctrl+Start+Shift+[

Vertical zoom to show all tracks Option+A Alt+A

Horizontal zoom to show all tracks Option+Control+A Alt+Start+A

Horizontal zoom and scroll timeline excluding MIDI events Option+F Alt+F

Horizontal zoom to selection, including MIDI events Option+Control+F Alt+Start+F

Continuously zoom vertically on a single audio track (or 
group of tracks)

Control+drag with the Zoomer tool up 
or down in the track

Start-drag with the Zoomer tool up or 
down in the track

Continuously zoom vertically on all audio tracks Control+Shift+drag in an audio track 
with the Zoomer tool

Start+Shift-drag in an audio track with 
the Zoomer tool

Incrementally zoom vertically on all audio tracks Command+Option+[ or Com-
mand+Option+]

Press Ctrl+Alt+[ or Ctrl+Alt+ ]

Fill window with selection Option-click on Zoomer tool or 
Option+F

Alt-click on Zoomer tool or Alt+F

View entire session and reset waveform display to the 
default height

Double-click on Zoomer tool or 
Option+A

Double-click on Zoomer tool or Alt+A

Zoom to previous orientation Option-click on any Horizontal Zoom In 
or Out button, or Audio or MIDI Zoom In 
or Out button

Alt-click on any Horizontal Zoom In or 
Out button, or Audio or MIDI Zoom In or 
Out button

Maximum zoom before waveform drawn from disk (faster 
drawing from RAM)

Command-click on Zoomer tool Ctrl-click on Zoomer tool)

Zoom Toggle Control+E Start+E

Cancel Zoom Toggle and remain at the same zoom level Option+Shift+E Alt+Shift+E

Action Mac Windows
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File Menu Commands

• The following are shortcuts of commands found in the File Menu

New Session Command+N Ctrl+N

Open Session Command+O Ctrl+O

Open Recent Command+Shift+O Ctrl+Shift+O

Close session Command+Shift+W Ctrl+Shift+W

Save Session Command+S Ctrl+S

Bounce to Disk Command+Option+B Ctrl+Alt+B

Import Session Data Shift+Option+I Shift+Alt+I

Import Audio Command+Shift+I Ctrl+Shift+I

Import MIDI Command+Option+l Ctrl+Alt+l

Missing File Dialog Commands

• The following shortcuts apply to Missing File dialog

Skip all missing files Command+S Ctrl+S

Manually find and relink all missing files Command+M Ctrl+M

Automatically find and relink all missing files Command+A Ctrl+A

Regenerate missing fades (toggle on/off) Command+R Ctrl+R

Regenerate missing render files Command+D Ctrl+D

Edit Menu Commands

• The following are shortcuts of commands found in the File Menu

Undo Command+Z Ctrl+Z

Redo Command+Shift+Z Ctrl+Shift+Z

Cut Command+X Ctrl+X

Copy Command+C Ctrl+C

Paste Command+V Ctrl+V

Clear Command+B Ctrl+B

Select All Command+A Ctrl+A

Paste Special Merge Option+M Alt+M

Paste Special Repeat to Fill Selection Command+Option+V Ctrl+Alt+V

Paste Special to Current Automation Type Command+Control+V Ctrl+Start+V

Change Timeline Selection to Edit Selection Option+Shift+6 (on numeric keypad) Alt+Shift+6

Change Edit Selection to Match Timeline Selection Option+Shift+5 (on numeric keypad) Alt+Shift+5

Duplicate selection Command+D Ctrl+D

Separate Region at Selection Command+E Ctrl+E

Consolidate selection Option+Shift+3 Alt+Shift+3

Restore Last Selection Command+Option+Z Ctrl+Alt+Z

Action Mac Windows
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Memory Location and Markers

Create Memory Location Enter (on numeric keypad) Enter (on numeric keypad)

Edit a Memory Location Control-click on Memory Location 
marker

Start-click on Memory Location marker

Delete Memory Location Option-click on a Memory Location 
marker 

Alt-click on a Memory Location marker 

Recall a Memory Location using the numeric keypad Period (.)+Memory Location num-
ber+Period (.) (Transport or Shuttle 
mode),
or Memory Location number+Period (.) 
(Classic mode)

Period (.)+Memory Location num-
ber+Period (.) (Transport or Shuttle 
mode),
or Memory Location number+Period (.) 
(Classic mode)

Move only the Song Start Marker, without moving any audio 
data

Control-Shift-drag the Song Start 
Marker

Start-Shift-drag the Song Start Marker

Automation

Change to previous/next Track View on all tracks included in 
the current selection

Control+Command+Left/Right Arrow 
keys

Ctrl+Start+Left/Right Arrow keys

Change to previous/next Track View on all tracks Control+Option+Com-
mand+Left/Right Arrow keys

Ctrl+Alt+Start+Left/Right Arrow keys

Disable/enable Automation playlist on selected track Command-click on Track View selector Ctrl-click on Track View selector

Disable/enable all Automation playlists on selected track Command+Shift-click on Track View 
selector 

Ctrl-Shift-click on Track View selector 

Open Plug-in Automation dialog Command+Option+Control-click on 
Track View selector (in Edit window)

Ctrl-Alt-Start-click on parameters (in 
Plug-in window) 

Suspend currently displayed automation type on a track Command-click the control name in the 
Track View selector

Ctrl-click the control name in the Track 
View selector

Vertically constrain automation movement Press Shift and move automation with 
Grabber tool

Press Shift and move automation with 
Grabber tool

Write new breakpoint to next automation value Press and hold Option+Shift while writ-
ing a breakpoint (by clicking with the 
Grabber tool in a track’s Automation 
playlist)

Press and hold Alt+Shift while writing a 
breakpoint (by clicking with the Grab-
ber tool in a track’s Automation play-
list)

Write new breakpoint to previous automation value Press and hold Command+Option 
while writing a breakpoint (by clicking 
with the Grabber tool in a track’s Auto-
mation playlist)

Press and hold Ctrl+Alt while writing a 
breakpoint (by clicking with the Grab-
ber tool in a track’s Automation play-
list)

Special Paste of automation data between different controls Command+Control+V Start+Ctrl+V

Configure Write on Stop modes to remain enabled after an 
automation pass (Pro Tools HD only)

Option-click one of the Write On Stop 
modes (Start, End, or All) to enable the 
Write On Stop mode

Alt-click one of the Write On Stop 
modes (Start, End, or All) to enable the 
Write On Stop mode

Display Automation playlist of automation-enabled plug-in 
control, track volume, or track pan

Command-Control-click on control

Delete Backspace Backspace

Cut Command+X Ctrl+X

Copy Command+C Ctrl+C

Duplicate Command+D Ctrl+D

Clear Command+B Ctrl+B

Action Mac Windows
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Fades

Create Fades (open Fades dialog) Command+F Ctrl+F 

Apply crossfade without opening Fades dialog Command+Control+F (uses last 
selected fade shape)

Ctrl+Start+F (uses last selected fade 
shape)

Fades Dialog

• The following shortcuts apply to the Fades dialog

Edit crossfade-in only in Fades dialog Option-drag fade-in curve (“None” Link 
mode only)

Alt-drag fade-in curve (“None” mode 
only)

Edit crossfade-out only in Fades dialog Command-drag fade-out curve (“None” 
Link mode only)

Ctrl-drag fade-out curve (“None” Link 
mode only)

Audition start/stop in Fades dialog Spacebar Spacebar

Reset to default zoom in Fades dialog Command-click on Zoom In or Zoom 
Out buttons

Ctrl-click on Zoom In or Zoom Out but-
tons

Reset standard or S-shape crossfades to default curves Option-click fade curve in crossfade 
fade window (“Equal Power” and 
“Equal Gain” Link modes only)

Alt-click fade curve in crossfade fade 
window (“Equal Power” and “Equal 
Gain” Link modes only)

Cycle up/down through Out Shape parameter options Control+Up/Down Arrow keys Start+Up/Down Arrow keys

Cycle up/down through In Shape parameter options Option+Up/Down Arrow keys Alt+Up/Down Arrow keys

Cycle up/down through Link parameter options Up/Down Arrow keys Up/Down Arrow keys

Cycle up/down through preset Out Shape curves Control+Left/Right Arrow keys Start+Left/Right Arrow keys

Cycle up/down through preset In Shape curves Option+Left/Right Arrow keys Alt+Left/Right Arrow keys

View Menu Commands

• The following shortcut command is found in the View Menu

View Narrow Mix window option Command+Option+M Ctrl+Alt+M

Track Menu Commands

• The following are shortcuts of commands found in the Track Menu

New Track Command+Shift+N Ctrl+Shift+N

Duplicate Tracks Option+Shift+D Alt+Shift+D

Clear all Clip indicators Option+C Alt+C

New Tracks Dialog 

• The following shortcuts apply to items in the New Tracks dialog

Cycle through Track Type choices Command+Up/Down Arrow keys Ctrl+Up/Down Arrow keys

Cycle through Track Format choices Command+Left/Right Arrow keys Ctrl+Left/Right Arrow keys

Add or delete a Track Entry field Command+Plus/Minus (+/–) keys or 
Command+Shift+Up/Down Arrow keys

Ctrl+Plus/Minus (+/–) keys, or 
Ctrl+Shift+Up/Down Arrow keys

Re-arrange Track Entry field (move up/down) Drag the Move Row icon (at the right of 
each Track Entry row) to desired posi-
tion

Drag the Move Row icon (at the right of 
each Track Entry row) to desired posi-
tion

Action Mac Windows
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Region Menu Commands

• The following are shortcuts of commands found in the Region Menu

Loop Region Command+Option+L Ctrl+Alt+L

Quantize Region to Nearest Grid Command+0 (zero) Ctrl+0

Region List

• The following shortcuts apply to items in the Region List

Select region by name Click the Region List a–z button, then 
type the first letters of the desired 
region

Click the Region List a–z button, then 
type the first letters of the desired 
region

Clear selected regions Command+Shift+B Ctrl+Shift+B

Rename selected regions Command+Shift+R Ctrl+Shift+R

Time Stamp selected regions Command+Shift+M Ctrl+Shift+M

Select or deselect a region Command-click a region Ctrl-click a region

Select multiple contiguous regions Click one region, then Shift-click 
another region to select all regions 
between 

Click one region, then Shift-click 
another region to select or deselect all 
regions between 

Select or deselect multiple discontiguous regions with the 
Marquee

Place the cursor to the left of the 
names in the Region List. When the 
Marquee (“+”) appears, hold Com-
mand and drag to select or deselect 
the desired regions

Place the cursor to the left of the 
names in the Region List. When the 
Marquee (“+”) appears, hold Ctrl and 
drag to select or deselect the desired 
regions.

Bypass dialogs during deletion of audio files Option-click Delete or Yes when 
prompted

Alt-click Delete or Yes when prompted

Audition region in Region List Option-click and hold on region in 
Region List

Alt-click and hold on region in Region 
List

Rename region/file Double-click region in Region List, or 
double-click with Grabber tool on 
region in playlist

Double-click region in Region List, or 
double-click with the Grabber tool on 
region in playlist

Constrain region placement to start at play/edit cursor loca-
tion or selection start

Control and drag region Start-click and drag region

Constrain region placement to end at play/edit cursor loca-
tion or selection start

Command+Control and drag region Start-Ctrl-click and drag region

Event Menu Commands

• The following are shortcuts that apply commands found in the Event Menu

Open Event Operations window Option+3 (on numeric keypad) Alt+3 (on numeric keypad)

Quantize (in Event Operations window) Option+0 (on numeric keypad) Alt+0 (on numeric keypad)

Transpose (in Event Operations window) Option+T Alt+T

Identify Beat Command+I Ctrl+I

All MIDI Notes Off Command+Shift+Period (.) Ctrl+Shift+Period (.)

Action Mac Windows
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Options Menu Commands: 

• See “Playback” on page 3 and “Record” on page 3.

Window Menu Commands

• The following are shortcuts of commands found in the Window Menu

Toggle Mix and Edit windows Command+Equal (=) Ctrl+Equal (=)

Show Task Manager Option+Apostrophe (‘) Alt+Apostrophe (‘)

Show Workspace Option+Semi-Colon (;) Alt+Semi-Colon (;)

Show Project Option+O Alt+O

Bring to Front Option+J Alt+J

Send to Back Option+Shift+J Alt+Shift+J

Show Transport Command+1 (on numeric keypad) Ctrl+1 (on numeric keypad)

Show Big Counter Command+3 (on numeric keypad) Ctrl+3 (on numeric keypad)

Show Automation Enable Command+4 (on numeric keypad) Ctrl+4 (on numeric keypad)

Show Memory Locations Command+5 (on numeric keypad) Ctrl+5 (on numeric keypad)

Machine Track Arming Command+6 (on numeric keypad) Ctrl+6 (on numeric keypad)

Show Video Universe window (Pro Tools HD and Pro Tools 
LE with DV Toolkit 2 only)

Command+7 (on numeric keypad) Ctrl+7 (on numeric keypad)

Show Video Command+9 (on numeric keypad) Ctrl+9 (on numeric keypad)

Open MIDI Editor Control+Equal (=) Start+Equal (=)

Cycle through all open MIDI Editors Control+Equal (=)repeatedly Ctrl+Equal (=) repeatedly

Open Score Editor Option+Control+Equal (=) Alt+Start+Equal (=)

Access Video window commands (Pro Tools HD and 
Pro Tools LE with DV Toolkit 2 only): Online, Video Out 
Firewire, Half Size, Actual Size, Double Size, Fit Screen

Control-click (or Right-click) in the 
Video window

Right-click in the Video window

Access Video Universe window commands (Pro Tools HD 
and DV Toolkit 2 only): Video Universe, increase, decrease

Control-click (or Right-click) in the 
Video Universe window

Right-click in the Video Universe win-
dow

Import Audio Dialog

• The following shortcuts apply to the Import Audio dialog

Start/stop audition of currently selected audio file/region Command+P, or Command+Spacebar Spacebar

Add currently selected audio region or file to list Command+A
(if audio file has the same sample rate 
and bit depth as the current session)

Alt+S (if audio file has the same sam-
ple rate and bit depth as the current 
session)

Convert and import selected audio region/files Command+C Alt+O (letter)

Remove currently selected audio files/regions from Regions 
to Import field

Command+R n/a

Random-access fwd/rew search selected file Drag slider to, or click at, new location Drag slider to, or click at, new location

Audition selected file Command+P Alt+P

Move between file windows Tab Tab

Cancel Escape Escape

Done Command+W Alt+E

Action Mac Windows
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DigiBase Shortcuts
The following shortcuts are available in DigiBase windows (such as the Workspace browser and the Task Manager).

Action Mac Windows

Global DigiBase Shortcuts

Open the Workspace browser Option+Semi-Colon Alt+Semi-colon

Open the Task Manager window Option+Apostrophe (‘) Alt+Apostrophe (‘)

Cycle to previous/next browsers Command+Left/Right Arrow keys Ctrl+Left/Right Arrow keys

Auditioning

Browser Item: Start or stop auditioning from head (when 
Spacebar Toggle File Preview is enabled)

– or –
Audio Import dialog:
Start or stop auditioning from head

Spacebar Spacebar

Browser Item: Start or stop loop auditioning from head Option+Spacebar Alt+Spacebar 

Start or stop preview when browser is front-most window Command+P Ctrl+P

Stop preview when browser is front-most window Escape Escape

Start and stop Context Preview in the front-most browser 
during session playback

Press Esc or Command+P Press Esc or Ctrl+P

Enable/disable Loop Preview mode Control-click the Preview button Start-click the Preview button

Enable/disable Auto-Preview mode Command-click the Preview button Ctrl-click the Preview button

Start or stop auditioning Command+P Alt+P

Delete or Duplicate

Region List: Delete selected Region from the timeline

– or –
Browser Item: Delete items from the browser/disk

Delete Delete

Delete locked files selected in a browser Command+Delete Ctrl+Delete

Delete any selected browser item, and suppresses any 
warning dialog

Option+Delete Alt+Delete

Create duplicates of any selected files Command+D Ctrl+D

Mouse Click

Select contiguous items in a browser or column headers Shift-click Shift-click

Select all of the files in a multichannel file in a browser Option+Shift-click Alt+Shift-click

Column Headers: Make a secondary sort order

– or –
Region List: Audition a file

– or –
Browser Find Button: Cancel a search, and closes the 
Search pane

– or –
Browser Close Box: Close all open browsers

Option-click Alt-click
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Column Header: Access list of columns that can be shown 
or hid

Control-click in any DigiBase column 
label

Start-click (or Right-click) in any 
DigiBase column label

Browser Back Button: Open the navigation menu

– or –
Browser Items: Select discontiguous items

– or –
Column Headers: Select discontinuous column headers

– or –
Browser Up Button: Open menu for navigating up several 
levels

– or –
Browser View Preset Buttons: Store column order and 
width, and sort order

Command-click Ctrl-click

Region List: Select a region without changing which region 
is highlighted in Timeline

Control-click Ctrl-double-click

Browser Items: Open a new window and leave the original 
window open

Command-double-click

Drag and Drop

Browser Item: From one folder to another folder on the 
same volume, create a copy of that item in the target loca-
tion

– or –
Browser Media File to Region List or Timeline: Create a copy 
of the media file in the session’s Audio Files folder

Option-drag and drop Alt-drag and drop

Browser File: Import to Timeline and create a new track Shift-drag and drop Shift-drag and drop

Waveform Display: Set sync point and spots to Timeline

– or –
Region List: Open the Replace Region dialog (Pro Tools HD 
and Pro Tools LE with DV Toolkit 2 only)

Command-drag and drop Ctrl-drag and drop

Waveform Display: Set the sync point and spot to the Time-
line and copy the audio file

Command+Option-drag and drop Ctrl-Alt-drag and drop

Region List: Snap to head

– or –
Browser Audio File, from Name or Icon: Snap to head

– or –
Browser Audio File, from Waveform Display: Spot to tempo-
rary sync point

Control-drag and drop Start-drag and drop

Browser Audio File to Timeline: Snap to head and copy the 
audio file to the session’s Audio Files folder

Control+Option-drag and drop Start-Alt-drag and drop

Region List: Snap to sync point

– or –
Browser Item: Snap to sync point

Control+Shift-drag and drop Start-Shift-drag and drop

Browser Item: Snap to sync point and copy the audio file to 
the session’s Audio Files folder

Control+Option-Shift-drag and drop Start-Alt-Shift-drag and drop

Region List: Snap to tail

– or –
Browser Item: Snap to tail

Control+Command-drag and drop Start+Ctrl-drag and drop

Action Mac Windows
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Browser Item: Snap to tail and copy the audio file to the ses-
sion’s Audio Files folder

Control+Command+Option-drag and 
drop

Start+Ctrl+Alt drag and drop

Browser Item: Spot with variable cursor Control-Command-Shift drag and drop Start+Ctrl+-Shift drag and drop

Browser Item: Spot with variable cursor and copy the audio 
file to the session’s Audio Files folder

Control+Command+Option+Shift-drag 
and drop

Start+Ctrl-Alt+Shift-drag and drop

Navigation

Selection up Up Arrow key Up Arrow key

Selection down Down Arrow key Down Arrow key

Scroll Page up Page Up Page Up

Scroll Page down Page Down Page Down

Scroll to top of browser Home Home

Scroll to bottom of browser End End

Up one browser level (same as Up arrow icon) Command+Up Arrow key Ctrl+Up Arrow key

Open folder (new window) Command+Down Arrow key Ctrl+Down Arrow key

Open Show/Hide icon Right Arrow key Right Arrow key

Close Show/Hide icon Left Arrow key Left Arrow key

Cycle to next or previous browser Command+Left/Right Arrow keys Ctrl+Left/Right Arrow keys

Enter/exit Name Edit field Enter or Return Enter

Revert to original text Escape (Esc) key Escape (Esc) key

Open/close Search pane Command+F Ctrl+F

Move to next Search field Tab Tab

Move to previous Search field Shift+Tab Shift+Tab

Action Mac Windows
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Right-Click Shortcuts
The following Right-click shortcuts apply to both Mac and Windows systems equipped with a two-button mouse. Right-clicking 
on the noted features allow you to perform commands and access menus (if applicable).

Feature Shortcut

Mix Window

Channel Input selector
Channel Output selector

• Make Active/Inactive
• Rename

Send selector Access send assignment views

Send Assignment button • Mute
• Make Active/Inactive
• Rename

Insert Assignment button • Bypass
• Make Active/Inactive
• Automation dialog (plug-ins only)
• Automation Safe (plug-ins only)
• Rename (hardware I/O only)

Track name
(in Mix window, Edit window and 
Track List)

• Scroll Into View
• Delete

Edit Window

Region, region selection, or point in 
region
(Blocks and Waveform Track views)

• Tools
•Zoomer
•Trimmer
•Selector
•Grabber
•Pencil

• Insert
•Key Signature
•Meter

• Cut
• Copy
• Paste
• Clear
• Separate
• Delete Fades
• Snap to Next
• Snap to Previous
• Rename (region or region selection only)
• Loop
• Unloop
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Command+Right-click (Mac), 
Control+Right-click (Windows) 
region, region selection, or point in 
region 
(Blocks and Waveform Track views)

• Tools
•Zoomer
•Trimmer
•Selector
•Grabber
•Pencil

• Insert
•Key Signature
•Meter

• Cut
• Copy
• Clear
• Snap to Next
• Snap to Previous
• Rename
• Move Region Start to Selection Start
• Move Region Sync to Selection Start
• Move Region End to Selection Start
• Loop
• Unloop

Region, region selection, point in 
region (Aux Input, MIDI, and Instru-
ment track only)

• Tools
•Zoomer
•Trimmer
•Selector
•Grabber
•Pencil

• Insert
•Key Signature
•Meter

• Cut
• Copy
• Paste
• Merge
• Clear
• Separate
• Consolidate
• Mute
• MIDI Real–Time Properties
• Event Operations

•Quantize
•Transpose

• Open in MIDI Editor

Region List items • Clear
• Rename
• Recalculate Waveform Overviews
• Select Parent in Workspace
• Object Select in Edit window

Toolbar Show/Hide controls in Edit window Toolbar

Transport Window 

Transport Play button Access Playback modes:
• Loop
• Dynamic Transport

Transport Record button Access Record modes:
• Normal
• Loop

Feature Shortcut
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MIDI Editor Window 

Midi Editor window Notes Pane • Tools
•Zoomer
•Trimmer
•Selector
•Grabber
•Pencil
•Smart

• Insert
•Key Signature
•Meter

• Cut
• Copy
• Paste
• Merge
• Clear
• Separate
• Consolidate
• Mute
• Event Operations

•Quantize
•Transpose

MIDI Editor window toolbar Show/Hide controls in MIDI Editor window Toolbar

DigiBase

File in Name column of Browser 
menu

Access DigiBase Browser menu commands:
• Calculate Waveform
• Update Database for Selected
• Reveal in Finder
• Loop Preview

Preview button Access DigiBase Preview commands:
• Loop Preview
• Auto-Preview
• Spacebar Toggles File Preview

Feature Shortcut
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